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ABOUT THE ACCESS TO FINANCE TOOL

Access to finance is often a key challenge to implementing 

feasible initiatives in Eco-Industrial Parks (EIPs), whether at the 

level of park management entities or of tenant companies within 

the parks. Part of this challenge is the lack of information on what 

financing options are available in a way that can be easily accessed 

by private firms. To this end, the goal of the UNIDO EIP Access to 

Finance Tool is to guide park management entities and tenant 

companies to identify, review and access available financing 

options for feasible EIP initiatives for their industrial parks. 

Tool Rationale
Provide an overview of different types of financing 

mechanisms and their overall applicability to EIP initiatives

Provide overall guidance on how to successfully access 

different types of financing options

Facilitate exercises to identify available financing options 

nationally and internationally

Direct park management and companies to relevant 

websites and contact details of identified financing options, 

in order to access detailed information and take next steps. 

Tool Objectives

How to use the access to finance tool
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TAB 1 TAB 2 TAB 3 TAB 4 TAB 5

The Access to Finance Tool is built on a carefully researched database of available funding options in specific country 
contexts. Once the data has been collected following an extensive mapping exercise, it is used to populate a database 
which exists in a standalone excel tool with a user-friendly interface. Replicating this tool requires a two-stage process.
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HOW TO REPLICATE THE TOOL
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STAGE 1: DATA COLLECTION

UNIDO EIP Access-to-Finance Tool Replication Manual5

This section lays out the methodological considerations that need to be taken into account by 

the researcher as part of their work replicating the Access-to-Finance tool, in particular the data 

that underpins the tool database. 

WHAT DATA NEEDS 
TO BE COLLECTED?

A NOTE ON DATA 
INTEGRITY



The UNIDO EIP Access to Finance tool is intended 
to be an aid to decision-making when it comes to 
mobilising funding in support of an EIP initiative.  
It is therefore important that such decisions are 
based on the most complete and correct data 
possible. 

Data integrity therefore refers to the accuracy, 
consistency and completeness of the data stored 
in the database.  The following principles should 
thus be kept in mind:

Data Integrity begins during the data collecting 
phase;
Data integrity rules specify that the database 
contains the highest quality data from the 
highest quality sources;
Precise data means that it is clearly expressed, 
definite, accurate, correct and conforming to 
proper form.

A NOTE ON DATA INTEGRITY

DATA 
INTEGRITY VERIFIABLE

COMPLETE

ACCURATE

RETRIEVABLE
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When gathering information, the data should be based on both an understanding of the (i) search criteria and (ii) search 
results (see below).

WHAT DATA NEEDS TO BE COLLECTED?

A data collection questionnaire is available in Annex 1 and unpacks the components of each data column. Below is 
an example for the search criteria options. 

Type of organization seeking 
funding

Financing Sector Investment Instrument Financing Institution type Type of EIP initiative

All (large companies, SMMEs and Park 
Management)

Private Sector Loan Banks Climate change adaptation

Large companies Government Sector Grant Private Equity Property and utility maintenance

SMEs National donor funding Equity Venture Capital Occupational health, safety and 
hygiene

Park Management International donor funding Rebate Development finance institutions Community development

Other Public, Private, Community Debt/Guarantee Sovereign Wealth Funds Carbon capture and storage

Other (Foreign Governments, etc.) Debt/Loan Enterprise Development Program 
(Private Sector)

Energy efficiency (cogeneration, 
smart grid)

Crowdfunding Enterprise Development Program 
(Government Sector)

Environmental protection (pollution 
control, prevention and treatment)
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Type of organization seeking 
funding

Financing Sector Investment Instrument Financing Institution type Type of EIP initiative

Impact Investment Government Departments Green buildings

Social and Economic Impact Bond Other Green products and materials

Various Instruments Renewable energy (solar, wind, hydro 
etc.)

Sustainable land management, 
(sustainable agriculture, forestry)

Transport (urban rail/metro, electric, 
hybrid, roads)

Waste management (recycling, waste 
management)

Water (water efficiency, wastewater 
treatment)
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STAGE 2: CREATION OF TOOL INTERFACE 
AND DATABASE SETUP

UNIDO EIP Access-to-Finance Tool Replication Manual9

This section contains instructions on how to set up and populate the database upon which the 

tool is built. It is organised by the different tabs of the tool. 

TAB 1
INSTRUCTIONS

TAB 2
SEARCH 

FINANCING 
OPTIONS

TAB 3
SEARCH RESULTS

HIDDEN TAB
MAPPING

TAB 4
GUIDANCE ON 

ACCESSING 
FINANCE

TAB 5
CONTACT 

FINANCIAL 
INSTITUTIONS

DATABASE SETUP



TAB 1: INSTRUCTIONS

Illustration of the flow chart 
as it is displayed on the 
"Instructions" worksheet

Adding a shape

Access shape options from 
the Insert button on the 
excel main menu ribbon.

Go to the Shapes and click 
the drop-down arrow, 
and select the Rounded 
Rectangle icon

How to insert the 
tool flow chart 

1.1. COMPONENTS

Draw a rounded rectangle 
in the cells on the 
wo rks h e e t . 

Formatting a shape
To format the shape and 
add text, right-click and 
select edit text OR double-
click the shape.

Now add relevant text to 
the button

1

2

3

1 2

3

4

4
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The buttons below the 
main boxes in the flow chart 
are created in the same 
way except that they have 
hyperlinks added.

Note: Before adding the 
hyperlinks, you must first 
add the text that you want 
to display in the box. To add 
the text, right click on the 
button and select “Edit text” 
option.

Adding a hyperlink
Once you have added the 
text, right click on the box 
to get the option to add 
hyperlink to the box. To 
Hyperlink a document, 
we suggest placing the 
document on one of 
the worksheets on the 
workbook. In general, the 
hyperlink can also work with 
website links.

Under the 'Link to' section, 
select 'Place in this 
Document ' .

Under the 'Type the cell 
reference' section, type in 
the destination cell address.

Under the 'Or select a place 
in this document ' click to 
choose the particular sheet 
name. Click the OK button 
when done

Now, when you click on the 
rounded  rectangle, it will 
go to the specified cell of a 
specified sheet. 

1

2
3

1

2

3

4
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There are 2 documents 
embedded onto the 
document, the feasibility 
and pre-feasibility study 
templates:

To insert files into the 
excel

Click inside the cell into 
which you want to insert 
the word/excel file.

Click on the 'Insert' tab

Click on the 'Object' 
under the 'Text' group

Select 'Create from File'

Browse your file

Select the 'Display as icon' 
check  box  if you want to 
insert an icon linking to the 
files.

Click on 'OK'

Adding feasibility 
assessment 
documents

1

2

3

4

5

6

7

1

2

3

4
5

6

7
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To fit the document into 
a cell, right click on the 
document.

Select 'Format Object'

Click on 'Properties'

Select 'Move and size with 
cells'

Click 'OK'

1

2

3

4

5

1

3

4

5
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Type of 
organization 
seeking funding

Financing Sector Investment 
Instrument

Financing Institution 
type

Type of EIP initiative

All (large companies, 
SMMEs and Park 
Management)

Private Sector Loan Banks Climate change adaptation

Large companies Government Sector Grant Private Equity Property and utility maintenance

SMEs National donor 
funding

Equity Venture Capital Occupational health, safety and 
hygiene

Park Management International donor 
funding

Rebate Development finance 
institutions

Community development

Other Public, Private, 
Community

Debt/Guarantee Sovereign Wealth Funds Carbon capture and storage

Other (Foreign 
Governments, etc.)

Debt/Loan Enterprise Development 
Program (Private Sector)

Energy efficiency (cogeneration, 
smart grid)

Crowdfunding Enterprise Development 
Program (Government Sector)

Environmental protection (pollution 
control, prevention and treatment)

Impact Investment Government Departments Green buildings

Social and Economic 
Impact Bond

Other Green products and materials

Various Instruments Renewable energy (solar, wind, hydro 
etc.)

Sustainable land management, 
(sustainable agriculture, forestry)

Transport (urban rail/metro, electric, 
hybrid, roads)

Waste management (recycling, waste 
management)

Water (water efficiency, wastewater 
treatment)

TAB 2-3: DATABASE SETUP

Database setup 
is  based on the 
following two 
components

2.1 SEARCH CRITERIA OPTIONS

•	 Search criteria/options
•	 Search results

DATABASE

SEARCH 
CRITERIA/
OPTIONS

SEARCH 
RESULTS
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To build a database, add 
the following fields on a 
separate worksheet. 

3.1 TABLE FIELDS

1

On the database, the search 
criteria is hidden by default 
using the hide or display 
scroll bar. 

The scroll bar (circled in the 
illustration) can be toggled 
to either hide or display 
data as required. It expands 
and contracts the view 
when pressed. 

1

USER VIEW

3.2 ADDING THE SCROLL BAR

To add the scroll, highlight 
the data columns you need 
to expand and contract 
using the button. 

Select "Group" from the 
"Outline" option.

Select "Group" from the 
popup menu. 

2

3

4

2

3

4
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This creates the scroll button 
which can be toggled to 
either expand or contract 
the data selection as 
illustrated.

Data entries are added 
to the database from the 
"Search Results Finance 
Options" tab. The tab 
contains the raw data in 
columns A-P

3.3 ADDING DATA ENTRIES

USER VIEW

1
1
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To add data entries, 
navigate to the last row 
entry and enter a new row 
with the new information.

Once all the data entries 
have been captured. There 
is a need to ensure that the 
data is formatted as a table 
which will allow for data 
filters to be inserted. 

To format the data as a 
table

Click anywhere inside the 
raw data

Select "Format as Table" 
from the "Home" option on 
the excel ribbon. 

2

3

1

1

2

3
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3.4 SETTING UP THE DATABASE MAPPING

USER VIEW

The new data entries need 
to be added to a Mapping 
tab which is hidden by 
default. This needs to 
be created on a new 
worksheet in the Excel 
workbook. 

There are two main fields in 
the mapping section.

For each new data entry into 
the database, the name of 
the financing organization 
and the list of associated 
EIP initiatives needs to be 
added to the mapping tab.

These two fields are located 
on columns C-D.

In the screenshot to the 
left, all the 4 EIP entries for 
Africa Enterprise Challenge 
Fund (AECF) are entered 
individually against the 
company's name one after 
the other. 

Once the data has been 
entered on Columns C-D of 
the mapping tab as per the 
above instructions, the pivot 
in columns H-I need to be 
refreshed to update the 
new information (see USER 
VIEW for the result). 

1

1

2

2

3

3
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Refresh Pivot Table

Navigate to the Data tab on 
the ribbon 

Click on Refresh All

The information from 
the pivot feeds the "EIP 
Initiatives Result (Second 
Selection)" slicer that is 
on the "Search Finance 
Solutions" tab

USER VIEW

1

2

1

2
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SETTING UP THE PIVOT 
TABLE

The pivot table is based on 
the data entries in columns 
C-D of the mapping tab

To insert the pivot table

Click any cell within the data 
entries in columns C-D

Navigate to the Insert tab in 
the ribbon

Select the Pivot Table from 
the Tables options on the 
tab

In the popup menu

Leave the data range as pre-
selected and choose where 
you would like to place the 
pivot table, either on a new 
worksheet or in an existing 
worksheet.

If you select existing 
worksheet, then you need to 
click on the location where 
you want it placed.

Clicking in Cell H2 in this 
case populates the location .

Click on OK and the pivot 
table frame and fields 
populate (see screenshot on 
next page).

1

2

3

4

1

2

3

4

5

5
6

6 7

7
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Drag the "Name of the 
financing organization" 
and "EIP Initiatives Search" 
data fields into the rows 
area of the fields. 

Result when data is 
formatted correctly with the 
pivot table.

1
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TROUBLESHOOTING

If for some reason, the final 
data is not formatted side by 
side like in the table on the 
previous page 

Click any cell inside the pivot

Navigate to the Design tab 
under PivotTableStyles

Click on Report Layout

Select Show in a Tabular 
Form

1

2

3

4
1

2
3

4
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INSERTING THE SLICER 
FOR THE PIVOT TABLE

To insert the slicer for the 
EIP Initiatives Search:

Click any cell in the pivot

Select the Analyze option in 
the ribbon

Click on Insert Slicer and 
the slicer option box will pop 
up

Click on the "EIP Initiatives 
Search" option 

Click OK

Once you click OK, the 
slicer will populate the 
information.

Cut and paste the slicer 
and place it alongside the 
other slicers in the Search 
Finance Options tab

1

2

3

4

5

1

2

3

4

5
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3.5 SETTING UP THE SEARCH CRITERIA (INSERTING REMAINING SLICERS

The Search Criteria is 
done through selections 
on slicers based on the 
"Search Results Finance 
Options" tab (See USER 
VIEW).

The slicers are inserted 
from the "Search Results 
Finance Options" tab

To insert the slicers

Click anywhere inside the 
data table

Click on "Insert Slicer" in the 
Design Table Tools. 

A box with slicer options will 
pop up (see next page).

USER VIEW

1

2

1

2
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To the left, the box with 
slicer options. The options 
are based on the table 
headings. 

This is the slicer selection 
for the Access-to-Finance 
database.

Click on the "OK" button 
and the slicers tables will 
populate

See next page for how this 
looks. 

2

1
1

2
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Note: The "Type of EIP 
Initiatives Search" slicer 
does not pull up unique 
values due to the set up 
where the field lists all the 
EIP initiatives separated by a 
comma.

All the slicers now need to 
be added to the dedicated 
worksheet to insert all 
the filters for the search 
criteria which will keep the 
database neater.

Cut and paste the slicers to 
the dedicated worksheet 
(Search Results Finance 
Options tab  for this tool)

To select and cut the slicers, 
press control on your 
keyboard and select the 
individual slicer tables.

Once all slicer tables are 
selected, right-click, cut and 
paste in the desired tab.

2

1

3
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3.6 SETTING UP THE BUTTONS FOR SEARCH FINANCING DATABASE

The 3 buttons on the tab 
are illustrated here. 

To insert the buttons, use 
the Shapes option.

On the main menu ribbon, 
click on the Insert tab

Go to Shapes and click the 
drop-down arrow

Select the Rounded 
Rectangle icon. 

USER VIEW

1

2

1

2

3

3
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This allows you to draw a 
rounded rectangle in the 
cells on the worksheet.

To format the shape and 
add text into the box, right-
click on it OR double click 
on the shape and select Edit 
Text

Enter relevant text into the 
button

To turn the shapes into 
buttons, you need to add 
hyperlinks and the one 
displaying the search 
results is linked to a 
dynamic formula. 

Once the text has been 
added, right click on the 
box to get the option to add 
hyperlink to the box. This will 
bring up a popup menu.

Under "Link to" column, 
select "Place in This 
D o c u m e n t " 

Under the "Type the cell 
reference" section, type in 
the destination cell address. 

Under the "Or select a place 
in this document" box, click 
to choose the particular 
sheet name

Click OK

2

1

3

4

5

6

7

1

2

3

4
5

6

7
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ADDING THE FORMULA 
FOR THE SEARCH RESULTS

To hyperlink an excel formula 
for the search results button:

The formula to calculate the 
number of search results:

= SUBTOTAL(2,'Search Results 
Finance Options'!A:A)&" 
"&"RESULTS"

The formula is currently 
hidden in A1 of the mapping 
tab (see screenshot)

Use this cell reference (= 
Mapping!A1) to hyperlink 
the result button (this is 
where the formula that 
calculates the hits is housed) 

The results button needs 
to be copy-pasted into the 
Search Results Finance 
Options tab. 

2

1

3

4

1

2

3

4
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TAB 4: GUIDANCE WORKSHEET

Various documents such 
as checklists and guidance 
notes were added to 
the database under the 
"Guidance A2F" tab.
•	 To insert the 

documents, they first 
need to be saved 
somewhere in the 
computer.

•	 Create a new 
worksheet to place the 
guidance information 
and notes.

4.1 ADDING THE "GO TO INSTRUCTIONS" BUTTON

The button is added as per 
the previous instructions 
under Section 5.6: Setting 
up the buttons for search 
financing database.

The difference is that this 
button hyperlinks the 
Instructions page as 
highlighted.

2

1

1

4.2 DATA ENTRIES ON THE GUIDANCE TAB

2 Data is entered on the tab 
and merged for a neater 
appearance. 

2
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Select the cells you want to 
contain the data and choose 
the "Merge & Center" 
option from the Alignment 
Options on the Home tab 
on the Ribbon. 

4.3 SETTING UP THE DROP DOWNS FOR RESPONSES

USER VIEW

Data validation is used for 
the responses in Column 
F with only pre-set options 
available for selection on 
the drop-down button. 

1

1
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The data validation is set up 
from the Data Validation 
option from the Data group 
on Ribbon. 

Once you select Data 
Validation, a menu 
appears.

Go under Settings

Select List under 'Allow' 

Add the following drop-
down options under 
Source:
'Please select', 'Yes', 'No', 
'To be confirmed'

22

You can drag the data 
validation across multiple 
cells by pulling the handle 
on the bottom right of the 
cell.

1

1

3

4

3

4

5 5
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To insert the files into the 
excel cells:

Click inside the cell into 
which you want to insert the 
word/excel file

Click on the "Insert" tab

Click on "Object" under the 
Text group

Select "Create from File"

Browse your file

Select the "Display as icon" 
check box  if you want to 
inset an icon linking to the 
files.

Click on "OK"

4.4 ADDING THE DOCUMENTS

2

1

3

4

5

6
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To fit a document into 
a cell, right click on the 
document and select 
"Format Object" option

Click on Properties

Select the option "Move and 
size with cells"

Select OK

2

1

3

1

2

3
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TAB 5: CONTACT FINANCIAL INSTITUTIONS FORM

The button is added as per 
the previous instructions 
under Section 5.6: Setting 
up the  buttons for search 
financing database.

The difference is that 
this button hyperlinks 
the Instructions page as 
highlighted

5.1 ADDING THE "GO TO INSTRUCTIONS" BUTTON

1

1
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This is a snapshot from the 
contact financial instutions 
form

5.2 DATA ENTRIES ON THE CONTACT FINANCIAL INSTITUTIONS FORM 

1 Data is entered on the tab 
and merged for a neater 
appearance

1
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1 To merge the data, select the 
cells you want to contain the 
data and choose the “Merge 
& Center” option from the 
Alignment Options on the 
Home tab on the Ribbon 

1
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ANNEX 1: DATA COLLECTION QUESTIONNAIRE 
This questionnaire can be used as an aid by the researcher to collect 
data on various funding sources and options

ADMINISTRATIVE DATA

Name of interviewer/fieldworker

Date of interview

1. Name of company

2. Name of respondent

3. Contact details of 
respondent

Email:

Website:

Office/cell phone no.: 

4. Type of organizations you fund

1. Park Management                 4. Various
2. Large companies                   5. Other, specify
3. SMEs 

5. Define which financing sector you belong to

1. Private sector                           4. International donor
2. Government sector               5. Public,private, community
3. National donor funding       6. Other, specify

6. Type of Investment Instrument

1. Loan                                            8. Green bond
2. Grant                                          9. Impact investment
3. Equity                                        10. Social and dev. impact bond
4. Rebate                                      11. Lottery funds
5. Debt Guarantee                     12. Crowdfunding
6. Debt                                          13. Various
7. Subsidy                                     14. Other, specify

7. What type of financing organization are you?

1. Banks                                        6. Enterprise dev. programme–     
2. Private equity                             Private Sector
3. Venture capital                      7. Enterprise dev. programme–
4. Development Finance            Government Sector
5. Sovereign wealth fund        8. Government department
                                                       9. Other, specify

8. Type of EIP initiative

.	1 Climate change 
adaptation (flood control 
channels, dykes, natural 
cooling)

.	2 Property and utility 
maintenance

.	3 Occupational health, 
safety and hygiene

.	4 Community development
.	5 Carbon capture and 

storage
.	6 Energy efficiency (process 

changes, cogeneration, 
smart grid, heating/
cooling)

.	7 Environmental protection 
(monitoring (park-
level) pollution control, 
prevention and treatment

.	8 Green buildings, park 
infrastructure

.	9 Green products and 
materials

.	10 Renewable energy (solar, 
wind, hydro, biomass, 
hydrogen)

.	11 Sustainable land 
management, 
(sustainable agriculture, 
forestry, park green 
areas, water catchment 
management)

.	12 Transport (urban rail/
metro, electric, hybrid, 
roads)

.	13 Waste management 
(reuse/recycling, waste 
management)

.	14 Water (water efficiency, 
wastewater treatment), 
water reuse networks at 
park level

.	15 Other, specify

9. Indicate your financing thresholds

9.1 Minimum

9.2 Maximum

1. Name of Fund

2. Name of person 
responsible for 
administering the Fund/
Providing information and 
support

3. Contact details Email:

Office/cell phone number:

Organization url: 

4. What is the specific focus of the available funding

38



5. What are the criteria that would make a candidate eligible for funding?

6. What are the requirements/required documents needed to apply for 
funding

7. Do you know of other green funders?

1. Yes 2. No

7.1 If YES, please provide the following

Name of the organization

Contact details of the 
organization

URL of the organization

8. Would you or someone from your organization be available to meet with 
organizations seeking funding

1. Yes 2. No
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